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1 Text editor 

 

When you start editing and writing monographs for Alma Mater Press, we recommend using 

Microsoft Word or Apache Open Office Writer. The instructions below will be ready for a 

Microsoft Word 2016 text editor. 

 

2 Page size 

 

After opening a new blank document, it is first necessary to prepare the page or paper size. For the 

publication of monographs of the scientific monograph published by Alma Mater Press, we 

suggest the following parameters of page size or paper: 

 

FORMAT:  

 

Width: 17 cm     

Height: 23 cm 23,5  

 

 
Picture 1: UZ format UM 17 x 23 
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FORMAT: A4 
 
Width: 17 cm 
Height: 23 cm 
 

 
Picture 2: UZ format UM A4 

  



 
 

 
 

You can set the size on the toolbar under the Layout tab -> Size -> More Paper Sizes... 

 

 
 

Picture 3: Setting the page size 1/2 

 

 
 

Picture 4: Setting the page size 2/2 
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3 Edges 

 

The default margin settings should be: 

 
Above: 

1.95 cm 
At the 
bottom: 

1.5 cm 

Inside: 
2.50 cm 

Outdoors: 
2 cm 

Binding edge: 
0 cm   

 

The orientation must be Portrait and  set Multiple Pages to mirror margins. 
 

 
 

Picture 5: Display margins 

  



 
 

 
 

You can set margins on the toolbar under the Layout tab -> Margins -> Custom margins... 

 

 
 
 

Picture 6: Margin settings 

 
4 Font 

 

The font should be Times New Roman. Font usage: 

 
FORMAT 17 x 23 

Use Font size K, L, P Example 
Plain (general text) 10 / Test 

Title 1 14 To Test 
Title 2 10 To Test 

Title 3 10 To Test 

Title 4 10 To Test 

Summary title 14 To Test 
Abstract authors 10 / TEST 

Head 9 Pom. v. č. TEST 

Header 2nd row 9 / Test 

Notes 9 / Test 

Footnote title 9 To Test 

Literature 9 / Test 

Title of literature 9 To Test 

Emphasis in text 1 10 To Test 

Emphasis in text 2 10 L Test 

Emphasis in text 3 10 K, L Test 
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FORMAT A 4 
Use Font size K, L, P Example 

Plain (general text) 12 / Test 
Title 1 16 To Test 
Title 2 12 To Test 
Title 3 12 To Test 
Title 4 12 To Test 
Summary title 16 To Test 
Abstract authors 12 / TEST 

Head 12 Pom. v. č. TEST 
Header 2nd row 12 / Test 
Notes 11 / Test 

Footnote title 11 To Test 

Literature 11 / Test 

Title of literature 11 To Test 

Emphasis in text 1 12 To Test 
Emphasis in text 2 12 L Test 
Emphasis in text 3 12 K, L Test 

 
Indent and spacing settings: 

 
General 

Alignment: Mutual Outline level: Body text 

Indentation 

Left: 0 cm Right: 0 cm 

Spacing 

Before: 0pt After: 0pt 

Line spacing: Single   

 

You can set indents and spacing on the toolbar under the Home tab -> Paragraph -> . 

 

 
 

Picture 7: Location of indent and spacing settings 

 



 
 

 
 

 
 

Picture 8: Indent and spacing settings 

 
5 Publication structure 

 

In order to achieve a quick and efficient preparation of the final format for the publication of a 

monograph in electronic form, the correct structure is crucial. The correct order of the monograph: 

 
1 Title page (cover, wrapping); 
2 Inside cover page in the language of publication; 
3 Release; 
4 Catalog record of the publication; 
5 Abstract, keywords and information about the author(s) in Slovene (in the 

case of a scientific monograph); 

6 Summary, keywords and information about the author(s) in English; (in 

the case of a scientific monograph); 

7 Table of Contents; 
8 Foreword (optional); 
9 Dedication (if desired); 
10 Content of the monograph; 
11 Finish; 
12 Used literature; 
13 Appendix (optional); 
14 Dictionary (optional); 
15 Index of things (optional); 
16 Tables of pictures, tables, graphs and sketches; 
17 Symbols used; 
18 Scientific review (in the case of a scientific monograph). 
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5.1 Cover page (cover, wrapping) 

 

The title page should be the fundamental colour, which is defined in the overall identity of Alma 

Mater Press. It should include the Alma Mater Press logo, the title of the book in Slovenian or 

English (depending on the monograph language used) should be written in bold, the reference to 

the avor/ev or editor(s) should be written normally, and the names and surnames of the avor/ev or 

editor(s) should be bold. The title page should contain the Alma Mater Press logo in the bottom 

right edge, with a minimum clearance of 1 cm from the bottom and right edges. The minimum 

allowable height of the Alma Mater Press logo is 1.5 cm. 

 

 
 

Picture 9: Example of a title page 

 

 
 

Picture 10: Position of the Alma Mater Press logo in Slovenian with the publication in Slovenian 

 
 
The title page is prepared by Alma Mater Press. 
  



 
 

 
 

5.2 Inside cover page in the language of the publication 

 

The next page after the cover page or inside cover should be a blank sheet with the Alma Mater 

Press logo (in accordance with the language of the publication). On the third page should be located 

inside the title page. It must contain the following mandatory elements: 

 

- Level 1: Alma Mater Press logo (according to the language of the publication). 

- Level 2: Publication title by font style Heading 1. 

- Level 3: Citation of author/author/author 

- Level 4: scientific title (dr., mag, Ph. D., M. S. ...), names and surnames. Each author or 

editor is on its own line. 

- Level 5: Month and year of publication. 

 

 
 

Picture 11: Example of an internal title page in Slovenian 

 
5.3 Release 

 

The rosin is a mandatory element of the publication on any medium and must contain the following 

information: 

 

- Title and subtitle; 

- The original title of the work (when translating); 

- Information about all authors  

 

(writer, translator, illustrator, photographer, organiser, cover word writer, other collaborators 

in the creation of the publication); 



 
 

12 
 

 

- Release or print data; 

- The title of the book collection and the count in the collection; 

- Publisher (address, country, telephone, fax, website and e-mail); 

- Publisher (address, country, telephone, fax, website and email); 

- Edition 

- Print (print publication only); 

- Publication date; 

- Information on the copyright holder(s); 

- Indication of license. 

- Indication of the public financer, if the publication is issued with the help of public funds; 

- Publication Catalog File (CIP) 

- International identifiers (ISBN, DOI, ISMN, ISSN); 

- Retail price of the publication; 

- The person in charge of the publisher. 

- Copyright holder, DOI link, ISBN and web link to full text. 

 

A catalogue record of the publication (CIP) is obtained by Alma Mater Press from the University 

Library of Maribor. 

 

International identifiers and price may also be printed on covers. 

 

The publication type, the sequence number of the issue or reprinting and other information in 

accordance with the preceding paragraph must be indicated in the roster of the new publication or 

reprint. In the case of facsimiles, facsimile and other information in accordance with the preceding 

paragraph shall be indicated in an additional masthead or elsewhere in the publication. The dotis 

roster must state that it is a dotis, and supplement the volume of circulation by indicating the 

original circulation and circulation of the dotis. 

 

The Colophon is also a mandatory part of the electronic publication and contains those information 

that, depending on the characteristics of the medium, can be provided, as well as information about 

the online location of the publication. Each time there is a change, a new web location information 

is added to its rosin. 

 

A monograph published in an electronic edition accessible at a distance shall be assigned a DOI. 

 

5.4 Summary, keywords and information about the author(s) in Slovenian and English 

 

If the monograph is written in Slovenian, first the odd page contains a summary, keywords and 

information about the author(s) in Slovenian and then a barrel of the page in English. If the 

monograph is written in English, the course is reversed. 

 

5.4.1 Summary title 

 

The title of the summary is the title of your monograph written with one space below the header, 

with the font type Time New Roman, size  14  (16 for A4 format), bold,  and center alignment. 

 

Under the title, indicate your first and last name to Time New Roman types, size 10 (12 for A4 

format), normal alignment, center alignment and font type  of reduced capital letter. 

 



 
 

 
 

5.4.2 Summary 

 

The abstract should be  no more than 150 words long and should contain the essence and brief 

overview of your monograph. 

 

5.4.3 Keywords 

 

List at least 5 keywords for your monograph. To make it easier to select words, we recommend 

that you put yourself in the role of a scientific works seeker who wants to search for your 

monograph through a search engine (example google.si) in an Internet browser. 

 

5.4.4 Information about the author(s) 

 

Note the information as a note to your last name above the summary. Indicate your first name, 

surname, title, place of work, name of the establishment of the place of work, full address of the 

place of work, country and your e-mail address for the post office. Before the information, write  

ADDRESS AVTOR/EV: / CORRESPONDENCE ADDRESS:. 
 

For the record, use: 

Time New Roman font type, size 9 (11 for A4 format), caption normal, two-sided alignment. 

 
5.4.5 Summary header 

 

The title of your monograph should be written in the abstract header: 

 

Time New Roman  font type, size 9 (11 for A4 format), normal caption, left alignment and 

reduced capital font type. 

The names and surnames of the author(s) or editor(s) should be written under the heading of the 

monograph in the header of the form "I surname": 

 

Time New Roman font type, size 9 (11 for A4 format), normal and left alignment. 

 

Alma Mater Press logo (according to the language of the publication) with right alignment. 

 

5.4.6 Summary and keyword margins 

 

The robbers in the summary area and keywords are slightly different from the other margins in the 

document. The offset is shifted according to the set values  Left: 1cm  and Right 0.97cm (Left: 

2cm and  Right 2.25cm for A4 format). The text is aligned on both sides. 

 

You can set the margins for this page from  the Layout-> Paragraph -> Indents  toolbar, or 

directly by dragging the marks on the ruler above the page. 

 

 
 

Picture 12: Summary and keyword margins 
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Picture 13: Example of summary pages, keywords and author information(s) 

 
5.5 Table of contents, images, graph tables, sketches ... 

 

An automatic table of contents is inserted 4 spaces below the header of the document. The index 

font type should be Time New Roman, size 10 (12 for A4 format)., the inscription  normal, two-

sided alignment. 

 

5.5.1 Indexing 

 

The table of contents shall be numbered separately from chapter No 1 onwards. There must be a 

space between chapter sections. 

 



 
 

 
 

 
 

Picture 14: Index example 
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++ 
 

Picture 15: Example of a conference proceedings index 

 
Under chapters are numbered in numerical order separated by a period and ending with one tab 

space. First number – title 1, second number – title 2, third number – title 3 ... 

 



 
 

 
 

 
 

Picture 16: Numbering example 

 
5.5.2 Index header - first page 

 

The 1-page index header is the same as in section 5.4.5 Abstract header. 

 

5.5.3 Index header - other pages 

 

In the first column is located the page number in Roman numerals. 

 

The second column contains the title of your monograph Time New Roman  font type, size 9 (11 

for A4 format), normal inscription, left alignment and  reduced capital font type. Your first and 

last name of form I. The surname should be written under the heading of monographs in the header, 

font type Time New Roman, size 9 (11 for A4 format), the inscription   normal and left 

alignment. 

 

For the odd side: 

 

The first column contains the title of your monograph Time New Roman  font type, size 9 (11 for 

A4 format), normal alignment, right alignment and  reduced capital font type. Your first and 

last name of form I. The surname should be written under the heading of the monograph in the 

header, font type Time New Roman, size 9 (11 for A4 format), the inscription normal and right 

alignment. 

 

In the second, column is located the page number in Roman numerals. 

 

 
 
 
 

Picture 17: Example of index header, odd - even page 
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5.6 Content of the monograph publication 
 
5.6.1 Home page 

 

Each chapter should begin on an odd page. If a new chapter happens to fall on an even page, then 

leave one page in between blank with the intersection of the page with the same page header as 

described in section 5.4.5 Abstract header. 

 

Each first page of the chapter should have a header as described in section 5.4.5 Abstract header. 

 

The chapter title is written four spaces below the page header and is written with Time New 

Roman  font type, size 12 (14 for A4 format), bold,  and center alignment. The text of the chapter 

shall be given two spaces under this heading. 

 

5.6.2 Other pages 

 

For other pages that follow in the chapter, a page header is created as a table with one row and two 

columns. 

 

For the soda side: 

 

In the first column is located the page number in Arabic numerals. 

  

The second column contains the title of your monograph Time New Roman font type, size 9 (11 

for A4 format), normal caption, left alignment and the font type  of the reduced capital letter. 

Your first and last name of form I. The surname should be written under the heading of 

monographs in the header, font type Time New Roman, size 9 (11 for A4 format), the inscription 

normal and left alignment. 

 

For the odd side: 

 

The second column contains the title of your monograph Time New Roman font type, size 9 (11 

for A4 format), normal caption, left alignment and the font type  of the reduced capital letter. 

Your first and last name of form I. The surname should be written under the heading of the 

monograph in the header, font type Time New Roman, size 9 (11 for A4 format), the inscription 

normal and right alignment. 

 

In the second, the column is located the page number in Arabic numerals. 

 



 
 

 
 

 
 

Picture 18: Example of the first and second pages of the chapter 
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Picture 19Example of the first page of a chapter in the conference proceedings 

 
 
 
5.6.3 Notes 

 

You can insert footnotes as endnotes at the end of each chapter. The font types Time New Roman, 

size 9 (11 for A4 format), the inscription normal, two-sided alignment,  must be indicated. The 

title  "Notes / Notes" should be written two lines below the last sentence of the chapter in bold and 

size  9 (11 for A4 format). 

 

5.6.4 Literature 

 



 
 

 
 

Literature can be found below the footnotes. In the absence of footnotes, the literature must be given 

two lines under the last sentence of the chapter with  size 9 (11 in the case of A4 format). We 

recommend quoting according to the Standard APA system. 

 
 

  
 
 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 21: Example of notes and literature 

 
6 Submission of monographs 

 

You can submit a monograph in word via e-mail: press@almamater.si 

mailto:press@almamater.si

